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Fill Handle 

The Fill Handle is in the bottom right corner of the selected cell. When you place your mouse over this 
handle, it changes from a thick white cross, to a thin black cross. Once you see the thin cross (no arrows) 
you can click and drag the cell to fill its contents in a single direction (up, down, left or right). If you want 
to go in two directions, you must first complete one way, let go of the mouse and then drag the handle 
in the second direction. 

When you use the Fill Handle to pull down a single number or plain text, it will copy the data. 

 
Text  123 
Text  123 
Text  123 

When you use the Fill Handle to pull down a text with numbers, a date, a month or a weekday it will fill 
in a series. 

 
Exam 1  2/1/02  February  Friday 
Exam 2  2/2/02  March  Saturday 
Exam 3  2/3/02  April  Sunday 

 
When you select two or more numbers (including dates) and then use the Fill Handle, Excel will fill in the 
series, following the original pattern of the selected cells. It can only follow simple addition and 
subtraction patterns. 

 
123  5  100  2/01/02 
124  4  110  2/08/02 
125  3  120  2/15/02 
126  2  130  2/22/02 

 

The Fill Handle will follow the format of the original cells. This includes number formats as well as 
capitalization, 

 
Friday  FRIDAY  fri  $123.00 
Saturday  SATURDAY  sat  $123.00 
Sunday  SUNDAY  sun  $123.00 

 

If you double-click on the Fill Handle it will 'fill' as many cells as the previous column has in use. 
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Fill Handle Options 
When you use the Fill Handle, you will notice a symbol appear in the right hand 
bottom corner of your newly filled cells. This icon ( ) represents your AutoFill 
Options. If you put your mouse over the icon you will see a drop down arrow that 
will give you a list of your fill options. 
 
The four basic Fill Options are: 

• Copy Cells – Repeat the cells along the selection 
• Fill Series – Follow pattern along the selection 
• Fill Format Only – Repeat the format of the cells along the selection 
• Fill without Formatting – Follow the pattern along the selection, but not the format 
• Flash Fill – Fills based on a pattern you establish in the same column 

 
If you use the Fill Handle on cells with dates you will notice even more options: 

• Fill Days 
• Fill Weekdays 
• Fill Months 
• Fill Years 

 

 Number Fill Options  Date Fill Options 

 

  
 
Mathematical Operations 
To let Excel know you expect it to "do math" you need start your cell with an equal sign (=). 

- Addition, plus sign (+) = 5+2 result 7 
- Subtraction, hyphen (-) = 5-2 result 3 
- (also used for negative) = -5 result -5 
- Multiplication, asterisk (*) = 5*2 result 10 
- Division, slash (/) = 5/2 result 2.5 
- Exponent/Power, caret (^) = 5^2 result 25 

 

There are several operands to use for logic comparisons. 
- Greater than, greater than sign (>) =5>2 result TRUE 
- Less than, less than sign (<) =5<2 result FALSE 
- Equal to, equal sign (=) =5=2 result FALSE 
- Not equal to, both greater and less than signs (<>) =5<>2 result TRUE 
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Building an Equation 

You can directly type in values, but that data stays constant. If you want to have the answers to your 
equations update as you change your data, you should use the cell addresses. You will see the cell 
addresses change colors so you can tell which ones are used in your equation. 

 

Type in the exact cell address 

Cells are labeled by their row and column headings. Rows are numbered and go horizontally across 
(rows of chairs) and columns are lettered and go vertically top to bottom (columns of a building). When 
we refer to the address of a cell, we use the column letter then the row number such as A1. 

- Click in the cell where the answer will appear 

- Press the Equal sign (=) 

- Type in the cell address you want to use in your equation 

- Accept the answer or press the next math operator (+, -, *, /, ^) 

 
 A B C 

1 1 2 =a1+b1 
2    

 

Use the keyboard to point to the cell address 

When you first enter a character into a cell, you will be in "ENTER" mode. This includes when you type 
an equal sign. But if you press an arrow key on the keyboard after the equal sign, Excel does not move 
out of the cell. Instead you will be put into a "POINT" mode, and Excel will color coordinate the cell you 
are selecting. 

- Click in the cell where the answer will appear 

- Press the Equal sign (=) 

- Press the arrow keys until you are on the cell you want to use in your equation 

- Accept the answer or press the next math operator (+, -, *, /, ^) 

 
 A B C 

1 1 2 =A1 
2    

 

Use the mouse to point to the cell address 

The mouse and arrow keys are both "pointers". If you press the equal sign and then use the mouse to 
click on another cell, Excel will put you into a "POINT" mode, and place the address of the cell you 
clicked on in your equation. 

- Click in the cell where the answer will appear 

- Press the Equal sign (=) 

- Use the mouse to click on the cell you want to use in your equation 

- Accept the answer or press the next math operator (+, -, *, /, ^) 
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Order of Operations 
Microsoft Excel respects the Order of Operations. 

(1) Parenthesis 
(2) Exponents (raised to a power) 
(3) Multiplication and Division 
(4) Addition and Subtraction 

 
Parentheses  Exponents  Multiply  Divide  Add  Subtract 
Please  Excuse  My  Dear  Aunt  Sally 
 

This means with an equation such as 
= 5 + 3 * 2 

Excel will do the multiplication before it does the addition. The result would be 11. 
 
If you wanted the addition to happen first, you have to use parentheses: 

= ( 5 + 3 ) * 2 
giving us a result of 16. 
 
In math, we use the brackets, such as 

{[(5+3)*(4-2)] / 2} 
 
In Excel we ONLY use parentheses 

=(((5+3)*(4-2))/2) 
result 8. 
 
Formatting Dates 
Dates and Times are technically numbers because they can be used in 
equations. Excel is able to do this because it has a "serial" number 
equivalent. Both columns of this table at the right of this page show the 
same value, but the dates in the second column have lost the date 
format. For a date, 0 = 1/1/1900. The numeric values in the second 
column represent how many days there are between 1/1/1900 and the 
date listed. 
 
If your date loses its format you can modify it through the Number group 
or through the Format Cells Window. If you don't like the choices offered, 
you can custom build your date from the Custom section of the Number 
tab in the Format Cells Window. Use M for months, D for days and Y for 
years. Excel is not case sensitive, upper or lowercase letters will work for 
these formats. 
 

Friday, February 1, 2002 
dddd, mmmm d, yyyy 

Day Month Year 
d 1 m 2 y 02 

dd 01 mm 02 yy 02 
ddd Fri mmm Feb yyy 2002 

dddd Friday mmmm February yyyy 2002 
 
You can also custom build times using H for hours, M for minutes and S for seconds. 

11/16/1978   28,810.00  
5/2/1982   30,073.00  

11/4/1986   31,720.00  
2/23/1993   34,023.00  

11/13/1995   35,016.00  
2/2/2002   37,289.00  

7/24/2008   39,653.00  
12/25/2010   40,537.00  

6/8/2013   41,433.00  
11/20/2018 43,424.00 

Remember to let Excel know you 
want it to calculate something; you 
have to start with an equal sign (=). 
 
If you get stuck inside an equation, 
or confused by a mistake, press Esc 
to cancel and try again. 
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Formula View 
Our cells display the formula results. If we want to see the equation, we have to look at the formula bar 
or edit the cell. Sometimes it helps to see all the equations on a worksheet. The button for this option is 
on the Formula tab, in the Format Auditing group. The keyboard shortcut is Control-Tilde, ctrl ~ (the 
wavy line above Tab, below Esc on your keyboard). 

 
 
You can also turn this on through the Excel Options. From the File Menu, choose Options. On the 
Advanced tab, under the Display Options for this Worksheet group, check the box next to Show 
formulas in cell instead of their calculated results. 
 
Calculated Results (normal view) 

 
 
Formula View 

 
 
The formula view will stretch out the columns and all the numbers appear to have lost their format, 
including the dates and some alignments. Be careful adjusting the column widths, if you shrink them in 
the formula view, it will proportionally shrink in the calculated results view. 
 
You can continue working in this view and print out the sheet with all the formulas showing. If you’re 
going to print this view, I recommend turning on the print headings from the Page Layout tab. 
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Absolute/Relative 
When you create an equation in Excel using cell addresses, Excel sets up the equation to have a relative 
reference. When you are using the Fill Handle or the Copy and Paste features the equation result is 
relative to the location of the data. For example: 
 
 

 
If this equation is copied into cell C2, or the Fill Handle is used to drag the equation down to C2, Excel 
will give you this result: 
 

 A B C D 
1 5 6 =A1+B1  
2 12 4 =A2+B2  
3     

 
Since the equation was moved down, between rows, only the row number changes. If instead we moved 
the equation across, the row numbers will remain the same, but the column numbers will change: 
 

 A B C D 
1 5 6 =A1+B1 =B1+C1 
2 12 4   
3     

 
The addresses in the equation are relative to where the answer is positioned. The equation in cell C1 of 
the table above states 'take the value of the cell that is two to the left from this cell and add it to the 
value of the cell that is one to the left from this cell'. When we fill or copy the cell over or down, the 
basic equation stays the same. 
 

If you do not want a number to move relatively you can make it absolute by using dollar signs ($) in the 
equation. The F4 button on the keyboard will place the dollar sign characters in for you while you are in 
Enter, Edit, or Point mode. (Think F4 -> FORCE) 
 

=$A$1 - Locks the reference into Cell A1 
=$A1  - Locks the reference into Column A, but will allow the row number to change 
=A$1  - Locks the reference into Row 1, but will allow the row number to change 

 
 A B C D E F G H I 

1 5 6 =$A$1+B1  SubTotals: 123 456 789  
2 12 4 =$A$1+B2  TaxRate: 6.5%    
3     Taxes: =F1*$F$2 =G1*$F$2 =H1*$F$2  

 A B C D 
1 5 6 =A1+B1  
2 12 4   
3     
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Class Exercise – Patterns 
 
Review 

- Open Excel 

- Click on Blank Workbook 
- Zoom to 150% 
- Reminder: Text on left, Numbers on the right 
- Remember to "accept data" 

o In Cell A1 type: 1 
 Press Ctrl-Enter to accept (stays on cell) 

o Clear A1 
o In Cell A1 type: 1 

 Click on Check next to formula bar to accept 

 (The X is the same as cancel) 
 

Fill Handle 
- In Cell A1 type: 1 ("accept data" for each of these) 

o Use the Fill Handle in the bottom right corner to drag down to row 8 
 1,1,1,1… 

- In Cell B1 type: text 
o Fill to row 8 

 text, text, text, text… 
- In Cell C1 type: text1 

o Fill to row 8 

 text1, text2, text3, text4… 
- In Cell D1 type: 1, In Cell D2 type: 2 

o Select both and Fill to row 8 
 1, 2, 3, 4… 

- In Cell E1 type: 2, In Cell E2 type: 4 
o Select both and Fill to row 8 

 2, 4, 6, 8… 
- In Cell F1 type: 5, In Cell F2 type: 4 

o Select both and Fill to row 8 
 5, 4, 3, 2… 

- In Cell G1 type: text 1 
o Double-click on fill handle 

 text1, text2, text3, 
text4… 
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Special Reserved Words 
Type the following into the cells listed and Fill using the double-click, or drag, down to row 8. 

- In Cell H1 type: Quarter 1 

- In Cell I1 type: 1st Qtr 
- In Cell J1 type: 1st 
- In Cell K1 type: 1 st 
- In Cell L1 type: January 

- In Cell M1 type: FEB 
- In Cell N1 type: Monday 
- In Cell O1 type: sat 

 

Working with Dates 
Type the following into the cells listed and Fill using the double-click, or drag, down to row 8. 

- In Cell P1 type: 10/20 
- In Cell Q1 type: 12/28/2024 

o Click on the Fill handle options, the box that pops up near the fill handle when you let go 
of the mouse. Try these settings: 
 Weekdays, Months, Years 

- In Cell R1 type: Enter the two paydays (example: 10/14, 10/28)  

o remember to select BOTH cells before you fill 
 

 
Class Exercise – Building Equations 

 
Sheet 2 

- Click on the Plus sign next to Sheet 1 to create Sheet 2 

 
 

- Zoom 150% 
- Create data set 

o A1: 1 
B1: 2 
A2: 2 
B2: 4 

o Select all four cells and use the fill handle and drag to Row 8 
 You can not double-click to fill this time because there is no previous column to 

match your selection 
o Leave the range selected and use the fill handle again to Fill to Row 12  
o Leave the range selected and use the fill handle again to Fill to Row 10 

 Yes, fill "up", backwards! 
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Creating Equations with constant values 
- In Cell C1 type: 1+2 

o Accept. Notice the "1+2" is on the left side of the cell meaning Excel sees "text" 

- Clear the contents of cell C1 (Delete) 
- In Cell C1 type: =1+2 

o Using the = sign as the first character tells Excel we are building an equation, we’re 
doing math. We see a 3 in the cell, but the formula bar displays =1+2 

o 1+2 always equal 3, but if we change data we want our answer to change 

Creating Equations with Cell addresses 
- Clear cell C1, type =a1+b1 

o Not case sensitive 
o Notice the color coding 
o Accept data, should get a 3 

o Change A1 to 5, accept to see answer in C1 change 
 

- USING KEYBOARD 
o Go to C2 

o press = sign 
o press  arrow two times 
o press + sign 
o press  arrow once 

o enter to accept 

- USING MOUSE 
o Go to C3 

o press = sign 
o click on cell A3 
o press the + sign 
o click on cell B3 

o click on check to accept

 

Basic math symbols 
- Add +, Subtract -, Multiply *, Divide / 

o All found on the NumPad 
- Build these equations 

o In Cell C4 add A4 and B4:  =A4+B4 
o In Cell C5 subtract A5 and B5:  =A5-B5 
o In Cell C6 multiply A6 and B6:  =A6*B6 
o In Cell C7 divide A7 and B7:  =A7/B7 

 

Remember the Order of Operations 
- Parenthesis, Exponents, Multiplication/Division, 

Addition/Subtraction 

- Build these equations 
o In Cell C8 type =2+3*5 
o In Cell C9 type =(2+3)*5 
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Date not Math? 
- Put today's date in cell C10 

o i.e. 10/5 

o Note Excel sees it as a date not as an equation (10 divided by 5), Why? Because there is 
no Equal sign! 10/5 is October 5th, =10/5 is a formula with a result of 2 

 

Totals Preview 
- Select Column A 
- Look in the status bar in the bottom right side of the window. When you select more than one 

cell, Excel will automatically calculate the Average, Count, and Sum of your selection. 

 
 

Formatting 
- Format column A with dollar signs 

o Select Column A, from the right-click or Home tab, choose the $ format 

- Format column B to be centered 
o Select Column B, from the right-click or Home tab, choose Align Center 

- Edit Cell C1 (double-click in cell) 
o When you accept, Excel recalculates answer and the format changes 

- Format Column C with dollar signs 

o Note format in cell C10, no longer a date 

 

Reformat Date 
- Click on Cell C10 (we don't want the whole column) 

- Choose Short date from the list of number formats, in the Number group on the Home Tab 
- Choose "More Numbers" to view different date formats 
- Choose the 14-Mar format to return to the original date formatting 

o To custom build a date format see page 6 

 

Formula View 
- Toggle cell data with ctrl-` (Ctrl-~… Wavy line above tab, 

below Esc) 

- We can see all the formulas but NO formatting 
- Toggle back to answer view 
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Class Exercise – Sales Report 
 
Create Data Table 

- Insert a new worksheet - Sheet 3 

- Zoom to 150% 
- Type in the data shown here 

 
 

Format Data Table 
- Row 4: Bold 

- Column B: Accounting ($) 
- Column C: Center and AutoFit Column Width 
- In Cell D4 type: SubTotal 

o Should be bold already 

 
 

Calculate SubTotals 
- Enter First SubTotal  

o In Cell D5 Type: = B5*C5 
 $121,401.00 

- Each total is going to be the Price of the item, times the Qty of the item. If we had 3,000 records, 
we would not want to type the equation 3,000 times 

o Our equation is a pattern, "the cell two away, times the cell next to me" 
o Anywhere you copy or fill 

the equation, the pattern 
will follow 

- Use Fill handle to pull down this 
"pattern" 

- Turn on the to Formula view 
(Ctrl-~) to see results  

- Turn off the Formula View 
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Calculate Taxes 
- In Cell E1 type: Tax Rate 
- In Cell E2 type: 10% 
- In Cell E4 type: Taxes 

- In Cell E5 type: =D5*E2 
o Our pattern is Subtotal times Tax Rate 

- Use fill handle to pull down equation 
o Don't Panic, these answers are supposed to look weird 

 

Absolute vs Relative 
- What Happened? 

o Pattern "Cell next to me * Cell three above me" 
o As we move DOWN the pattern continues but it’s wrong for this equation 

- Erase the answers 
- In Cell E5 type the same equation: =D5*E2 

o Before you accept, press the F4 button on the keyboard to lock cell address E2 
o =D5*$E$2 

 you can type in the $ signs, but F4 is often faster 
 Think FORCE for the F4 button 

o D5 is relative (always cell next to me) 
o $E$2 is absolute (always cell E2) 

- Use fill handle to pull down the equation 

 
 

Calculate Totals 
- In Cell F4 type: Total 
- In Cell F5 type: = D5+E5 

- Use fill handle to pull down the equation 
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Calculate Grand Total 
- In Cell E8 Type: Big City Store Grand Total 

o From the Home tab, Align Right 

 If it won’t let you, make sure you have accepted your entry (enter or ) 

- Click in Cell F8 

- Use AutoSum button Sigma - ∑ in the Editing group 
on far right of the Home tab 

o =SUM(F5:F7) 

o In English, this reads "Calculate the Sum of F5 through F7" 

 
Note: When you click the AutoSum button Excel looks for numbers above the current 
cell. If it can't find a number, it will look to the left.  The AutoSum button has a drop 
down menu to do quick calculations for Sum, Average, Max, Min, and Count. 

 

Confirm your answer 

- Select cells F5:F8 

- Look at the status bar in the bottom right of the window to see the Average, Count, and Sum 

o Sum should be $740,183.40 

 

Bonus Exercise – Payroll Report 
 
Create Data Table 

- Insert a new worksheet - Sheet 4 
- Zoom to 150% 
- Enter the data shown here 
- Format Titles to be Bold 
- Center Hours and PayRate 

- AutoFit Hours column 
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Calculate Net Pay and Deductions 
Anytime you are using numbers that are coming outside of your dataset, like we have defined here, 
you're probably going to need to "force" the numbers. For the first example, it was our TaxRate, for this 
one it will be the PayRate and the Deduction Rate (DedRate). Remember to use the F4 or type the $ in 
the equation.  

- Net Pay: Hours * PayRate 
- Deductions: Net Pay * DedRate 

 

Calculate Gross Pay 
- Create Gross Pay in E4 
- Gross Pay: Net Pay - Deductions 

 

Calculate Totals 
- Create a Totals line in Row 9 
- Use the AutoSum for the Hours, Net Pay, Deductions and Gross Pay 
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